Filing Ohio Motor Fuel Tax

Exporter Return

Using the Ohio Business Gateway

Beginning November 1, 2015, the Ohio Motor Fuel returns will be filed using the Ohio Business Gateway
(OBG). Attached are instructions of how to navigate the OBG.
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If you have any questions in regards to these instructions or filing the
Ohio Motor Fuel Tax, please contact the Excise and Energy Division at

(855) 466-3921.




Logging in

Navigate to the OBG Login Page at ohiobusinessgateway.ohio.gov

Ohio Business Gateway

Electronic Filing Services Login

Existing Users New Users

o — Creste 2n 08G Usemame
If you are starting a new business in Ohio, you may need more than just an 0BG

Usemame. Please click here to learn more
By logging in_ | agree to the terms of service

Forgot your usermame or word?  Having trouble logging in?  Review System R

For additional topics. please visit our Help and Support Page

For more information about the services

2 hioln sl G available through the Ohio Business Gateway.
i e i ,"v‘"',"y"‘ please visit our home page.




Sign in to OBG using your existing Username and Password.

If you are a new user to OBG, but an account for the entity already exists on OBG, you must contact the
OBG Administrator within your company to have them add you as a user.

If your company has never filed using OBG, click the Create an OBG Username. Additional instructions
for registering a new account on OBG can be found on our website at tax.ohio.gov.

HOSTATE OF OHIO

Ohio Business Gateway

14’) OBG 3.0 Modernization Project Stay up-to-date on our efforts to update the Ohio Business Gateway. Last update August 6,
2015.

Existing Users New Users
Usemame :  [otorFuell Create an OBG Username
If you are starting a new business in Ohio, you may need more than just an OBG
Password : Usemame. Please click here to leam more.

By logging in, | agree to the ferms of service

Forgot your username or password?  Having trouble logging in? ~ Review System Requirements

For additional fopics, please visit our Help and Support Page.

For more information about the services

d . i available through the Ohio Business Gateway,
hicgBsginefs Gateway, please visit our home page.
. Electronic Filing /
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From the Home Page, use the drop down menu found in the “Start a Service or Transaction” zone and

select “Ohio Taxation — Ohio Motor Fuel Tax”.

Home History Administration Logout

Home

Motor Fuel Electronic Fi
Company 1D : ==**1111

g Acct

If you do not h o a senvios o ransacton, please ses your company’s adminisirator(s) o request or verify your acosss,
Favorite Transactions. ‘

Go to Admi > My * Edit > User to establish or edit your list of favorite transactions.

Start a Service or Transaction
SEIBCt SEIVIC : | _Seloct Service--

-] ‘
~Select Service--
wp Opportunities for Ohioans with Disabilities — BSVI/BEP
RLELEES0 Ohio Taxation — New Account Registration and Fuel Permit
Ohio Taxation - Sales and Use Tax Created Date
There are no tra{Ohio Taxation — Employer Withholding

Ohio Taxation -~ Commercial Activity Tax
Ohio Taxation — Wireless 911 Charges

Ohio Taxaticn - Severance Tax

Ohio Taxation-Financial Institutions Tax

Ohio Taxation - Petroleum Activity Tax

Ohio Taxation — Horse Racing Tax

Ohio Job & Family Services - UC Tax

Municipal Taxation — Net Profit Tax

Municipal Taxation - Withholding Tax

Ohio Deferred Compensation

Ohio Dept. of Commerce - Unclaimed Funds

Equal Opportunity Division

InvestOhio

Ohio Development Services Agency

Ohio Taxation - International Fuel Tax Agreement

Ohio Taxation - Gross Casino Revenue Tax

- Kilowalt Hour Tax - Self-Assessing Purchaser
- Kilowatt Hour Tax

Ohio Taxation — Natural Gas Distribution Tax

Ohio Taxation — Ohio Motor Fuel Tax

Transactior|
There are no tra

To exit (logoff)

Home

Motor Fuel Electronic Filing Acct
Company ID : #1111

you do nt have access o a servioe o ran: st orverify your access

Jesse see your sompany's sdminst

Favorite Transactions
Go to Administration > My Information > Edit > User Preferences to establish or edit your list of favorite transactions.

Start a Service or Transaction
Select Service : [ahio Taxation — Ohio Motor Fuel Tax [=]

Ohio Taxation - Ohio Motor Fuel Tax

Ohio Motor Fuel Tax — Dealer
Ohio Motor Fuel Tax — Exporter

Ohio Motor Fuel Tax - Transporter

Ohio Motor Fuel Tax — Terminal Operator

Ohio Motor Fuel Tax Refund - Fuel sold out of Ohio or to US Gov.
Ohio Motor Fuel Tax Refund - Transit Buses

Ohio Motor Fuel Tax Refund - Industrial Purpose

Ohio Motor Fuel Tax Refund - Agricultural Purpose

Ohio Motor Fuel Tax Refund - School Districts

Ohio Motor Fuel Tax Refund - Casualty Loss

Ohio Motor Fuel Tax Refund - Retail Dealer Shrinkage Allowance




This is the Ohio Motor Fuel Tax page where you will begin all of your filing transactions and be able to
view your filing history. On the left hand side, you will see there are several filing options available:

e File a New Return
e Amend a Return
e Make a Payment

e eFiling History

OSTATE OF OHIO

MotorFuell  Tuesday

Ohio Motor Fuel Tax - Dealer Motor Fuel Electronic Filing Acct
i Tips

E] File a New Return Incomplete Transactions
If you left the site before you filed your retum, your saved draft will be listed below + Do not use the back button in your browser to
Ciick Resume to finish it, and Delete if you don'twant to keep it navigate.
The draft returns are ordered by the most recent at the top. o IO AT, DO IE T

» number and filing period are availabie
ﬁ\ Amend a Return No Incomplete Transactions
An original retum must be on file in order to file

an amended retumn.
+ Payments may be made with a checking or
savings account using ACH debit or through the
s Make a Payment Treasurer of State using ACH credit.

Filing History

+ View and print online flings through eFiling
History.

Wl <Filing History Session Time Out

+ Sessions have a time out limit of 20 minutes. If
the session time exceeds this limit, you will need
10log back into 0BG
Payment History

+ Find historical payments paid online through OBG
by clcking on the Home link 2t the top of this:
page
Browser Compatibility

« For optimal browser compatibility, please see
“Help'.

As well as these options, please note the “Tips” box to the right, and the “Help” link in the upper-right
corner. The “Tips” box will be updated for each page that you navigate to while processing your
transaction and will provide useful information that may assist your filing.



The “Help” link will take you to more specific information in regard to the tax and the filing of your
transactions as seen below.

Ohio Motor Fuel Tax - Exporter - General Information

"Beginning November 1, 2015," all beense holders must file returns and make payments electronscally.
Taxpayers wil fiie returns through the Ohso Busimess Gateway (OBG) and may make electronic payments
exther va the OBG or through the Treasurer of State’s Office

Motor Fuel tax returns and payments are due as follows:

Moathly Reporting Due Date:
Period:

February 28th
March 31st
April 30th

May 315t

June 30th

July 31st
August 31t
September 30th
October 318t
November 30th
December 31st
Jamusry 318t

: Total Gallonage for a2 apphcable Fuel Types
A pertinent information for completing Recept Schedules: 1B and 2E
.) AZ pertinent mformation for completing Disbursement Schedules: 7A and 7D

Payment Information

Motor Fuel tax pavments may be made via ACH debat. In order to use this method on OBG, vou will need the
followmg mformaton:

1.) Checking or Savings Account Routing Number
2.) Checking or Savings Bank Account Number

Payments may also be made through the Treasurer of State using the ACH credit option

Additional Services




File a Return
To file a new return, click the “File a New Return” button.

Ohio' 0 WELCO! (o]}
J STATE OF OHIO

Motor Fuel Electronic Filing Acct

i Tips
E] File a New Return Incomplete Transactions
If you left the site before you filed your retum, your saved draft will be listed below + Do not use the back button in your browser to
Ciick Resume to finish i, and Delete if you don't want to keep it navigate.

The draft returns are ordered by the most recent at the top.

»
ﬁ\ Amend a Return No Incomplete Transactions

Ohio Motor Fuel Tax - Dealer

* To file anew return, make sure your account
number and filing period are availabie

+ An original return must be on file in order to file
an amended retum

+ Payments may be made with a checking or
savings account using ACH debit or through the

s Make a Payment Treasurer of State using ACH credit.

eFiling History

+ View and print online flings through eFiling
History.

= .pe :

Wl eFiling History Session Time Out

- Sessions have a fime out it of 20 minutes, If
the session fime exceeds s [mi, you wil need
10 log back into OBG.
Payment History

+ Find historical payments paid online through OBG
by clicking on the Home link at the top of this
page.
Browser Compatibility

+ For optimal browser compatibilty, please see
“Help"”.

Enter your Account Number (8 digit Motor Fuel Tax Account Number) and Filing Period End Date. Next,
select the Type of Filing and the Method of Filing. Click “Next” to continue.

WELCO!

TATE OF OHIO

Ohio Motor Fuel Tax - Dealer Motor Fuel Electronic Filing Acct

@ select Filng Period | = Al iolds aro roquired

Tips
@ cnter information Account Number 30000000 + Corrections to the Account Number, Fiing Period
or Filing Type may be made on this page.
. Review and File Filing Period End Date 10/31/2015 B mmiddyyyy + Files will NOT be revalidated so please ensure.
that any changes made on this page correctly
Tyos of Fil @ Original match the information contained within the
‘ Confirmation ype of Filing nginal successiully validated, uploaded filefs).
© Amended
Method of Filing ) Upload Files

© Manual Form Entry

Cancel Next

**Note see page 16 for instructions on “Upload Files”. This example will cover the manual form entry
method.



Click the relevant tabs to select which schedules will need to be completed for your return.

e Receipts
e Disbursements

Under each tab, you will select the “Schedule Type” and “Product Type” to be entered.

“STATE OF OHIO

Ohic Motor Fuel Tax - Exporter MF OBG Test Acct
@ seicctFiing Periog Aecoun Nusbor
Tips
Fiing Period Ending 03302015 Original
© envernfomaton + W i crae v, oot use i
Use whote vaiues only
[ —— - e rerng gt v, ot e s, U
oty whale numbers
Receipts Disbursements
+ Use e Crate Scnscule Buon 1o CrEate e seiected

Scheduls Type.
+ Use e Back button fo retun 1o the previous page.

@ contimation

Select Schedule Type Select Product Type

* Usa the Review bution 1o proceed 1o the Review page.
Received Tax Paid Gal B) Gasoline Create Schedule ‘This: bulion DOEE NOT subml the ret)
. + Usa the Save and Exit button i you want fo save the cata
Received Tax Not Paid Gals (2E) Clear Diese erflered, ut are not ready fo submi your retun
Low-Sulfur Dyed Diesel + Mthere s no activiy o report, 59 o the Reviaw page

What You Will Nesd
+ Total Galknage for all Fuel Types being reponied.
+ All data necessary io complete Receipt Scheduies (18,
2E) that must be reported
+ All gats neceszary 1o complete DEaLrsEMEnt Schaduiss
LNG (74, 7D} thal must be reported
+ Qniy report e Scnedules that re sppiicanie to your
ratum

High-Sulfur Dyed Diesel
Kerasene

CNG

Propane

Other

Summary of Created Schedules

Schedule Type Product Type Gross Gallans.

Mo created schedules

Back Revew Save & Ext

*At any point of the filing session, you can use the “Save & Exit” button to save your work and resume it
at a later time. Clicking the “Save & Exit” button does not file the return.



Once the Schedule Type and Product Type are selected, click “Create Schedule” to start entering details

for your selections.

" CTATE OF OHIO

Ohio Motor Fuel Tax - Exporter MF 0BG Test Acct
@ seiect Fiing Penca Aceount Number
Tips
o Fiing Period Ending 09302015 Original
Enter Information + Whn entaring cumency vaes, ot not use decimals.
Use whoe vaiues only
@ rovenanitio + Whnen aniering gallon values, do not sa decima's. Use
any whole numbers
Disbursements.
+ Usa tha Creale Scheduls button to create the selected
@ confirmation Scheduie Type

+ Use tha Back button to return to the previous page.

Select Schedule Type Select Product Type « Use the Review bution 1o proceed 1o the Review page:
® Received Tax Paid Gals (18) Gasoline Craate Schadule This bution DOES NOT submd the retum.
+ Use the Save and Ext button I you want 1o save e data
Received Tax Not Paid Gals (26) ® Clear Diesel ariened, bu v Nt Fady 10 S YOur IR,

Low-Sulfur Dyed Diesel + nere s no actvly 1o repo, 343910 Me Rewew page

High-Sulfur Dyed Diesel What You Will Need
+ Total Gallonage for all Fusi Types being regoned.

Kerosen
resens + Al ata necessany 1 complete Receipt Scheduses (18
cNG 2E] that mast be reportad
N + Al data necessary 1o complede Dishursement Schodules
LNG 7A, TD) tha must be reparted
Propane * Ory epot e Schesdes vl v gl o o

Other

Summary of Created Schedules

Schedule Type Product Type Gross Gallns

No created schedules
RN - R



The schedule heading will show what schedule type and product type that was selected and is being
entered.

Enter all details in the “Add/View Record” section.

If entering multiple shipments or deliveries with the same seller and destination information, you can
check the box at the bottom of the form “On Save, copy highlighted fields to next record”. This will
display a new record with the same seller and destination details completed, but the document
information and gallons section will be blank for you to complete with the next record.

Once record is completed click “Save” at the bottom of “Add/View Record”.

RRgay -Bftorowo
STATE OF OHIO —

MF OBG Test Acct

Ohio Motor Fuel Tax - Exporter

@ seiectFiing Pericd Accaunt Number
Tips
. Filing Period Ending 0903012015 Original
© cuor nformation + nen st gl e, o vt use cecmas. Lse
only whols numbers
@ revewanaFie Receipts Schedule : Received Tax Paid Gals (1B) - Clear Diesel " e o o e rocord Rt selctad
- Use the Ciear button 0 remove the data fiom ai feds on
@ confrmation AddiView Record Created Records S
+ By placing a check in the box labeled “On Save, copy
Seller Name Destination State Document Date Received Gross Gallons. highighted fiedd to the next record” you can retain
numesous dsta elements on the Schore f 3sset n
Seller ID No ereated records creating new récarcs

+ Use the Save & Retum to Receipts Summary butlon to
review all ihe Recet Scheduies ihat have bean created
Tor the current relum,

Carrier Name

Carrier ID * Use the S: nd Exit button if want o save he cata

Crgn TN é TCN format must be entered as T-31-OH-3114. et ke b S
What You Will Need

Ofigin Cly To view a complete list of valid TCN codes, visit « 7ol Galonage o Fus Types beng reparea

Ongin State . :llda’.é n El:e_ﬁé&ﬂ?:?“nkh? Recept Schedules (18,

Destination TN 9 the IRS website using the link below. e esares

Destination City

Destination State

Mode —Select Mode— [+

Document Date Received 1y iy

Document Number

Net Gallons

Gross Gallons

Billed Gallons

Save Clear
» On Save, copy highlighted fiekis.to next record
If you close the window before clicking "Save & Return to Receipts Summary” or “Save & Exit,” the created records will not be saved.

‘Save & Retum Io Recelpts Summary Save & Bt

http://www.irs.gov/Businesses/Small-Businesses-&-Self-Employed/Terminal-Control-Number-TCN-
Terminal-Locations-Directory

10


http://www.irs.gov/Businesses/Small-Businesses-&-Self-Employed/Terminal-Control-Number-TCN-Terminal-Locations-Directory
http://www.irs.gov/Businesses/Small-Businesses-&-Self-Employed/Terminal-Control-Number-TCN-Terminal-Locations-Directory

After clicking “Save”, if any errors are found or information is missing, there will be a red message that
appears and the record will not move to “Created Records”

When a record is saved successfully, the record will be displayed under the “Created Records” column.
A saved record can be edited or deleted by selecting the option to the right of the record.

Once all information is entered and saved under “Created Records” select “Save & Return to Receipts

Summary” to continue to a different schedule and product type or to complete the return filing.

R ~-rorowo |
“STATE OF OHIO

Ohio Mator Fuel Tax - Exporter MF OBG Test Acct

@ scicct Fimg Perioa Account Number

) Fiing Period Ending 0973002015 Original
© entr ntomaton - e e gt e, g0 s cecimas L
oy Whale numpers

@ ReviewangFie Receipts Schedule : Received Tax Paid Gals (18) - Clear Diesel s e Sae U 1 363 e econd o s sescied
- Use the Ciear buson fa remove te data rom il fids an
@ confrmaton AddiView Record Created Records Freyieded

+ By placing a check in the box labeled “On Save, copy

Seller Name MF OBG Test Acct Destination Stats Document Date Received Gross Gallons ignighted fied to he next record” you can ratain
UMBMCUS Gata HATHAS 01 the SChecUIS 10 36851 in
Seller ID 550010022 PA 0940112015 55000 Ean Deiete el e
- Use the Save & Return 1o Riscsipts Summary butlon 1o
Carrier Name Jims Trucking review all e Receipé Schedules thal have been created
for the cuert retum
Carrier ID SaaEeEsat * Use fhe Sawe and Exit bution If you want o save the data
S entered, but are not ready to subimit yout retun.
What You Wil Need
Origin City Heath

+ Total Gallonage for Fusl Types being repcried

Onigin State OH + Al data necessary to complete Recelpt Schedues (18,
2} thal must be reported

Destination TCN

Destination City Scranten
Destination State PA

Mode J-TRUCK -

Document Date Received o4y mmiddryyyy
Document Number

Net Gallons

Gross Gallons.

Billed Gallons

Save Clear

fields to next record

g “Save & Return to Recaipts Summary™ or “Save & Exit,” the created records will not be saved,

Save 8 Ext

11



Each schedule that has been completed will show in the Summary of Created Schedules at the bottom
of each tab.

Selecting the “Show Schedule” button will allow the schedule to be edited or you can add additional
records. Selecting “Delete” will remove the entire schedule.

Ohio.go

MF OBG Test Acct

Ohio Motor Fuel Tax - Exporter

@ seicciriing Perca Actount Number
Tins
. Filing Period Ending  08/302015 Original
© Enter information - Wnen enteing currency valuss, 6 Nt use decinas.
Use whole values oniy.
@ Review and Fie + Wnen antering gakon vaes, 00 not use decimals, Use
enly whaie nambers
Disbursements
+ Usa the Creall Schedule bution o create the selecied
@ confimation Scheduie Type
+ Use the Back button to refum to Ihe previaus page.
Select Schedule Type Select Product Type

+ Use the Review button to proceed 1o the Feview page

® Received Tax Paid Gals (18) Gasoline Craate Scheduls his buitton DOES NOT submit the return.

+ Use fhe Save and Exit bution I you wani Io save the dala
entered, but are ot ready 1o submt yous retum.

Low-Sulfur Dyed Diesel + Il there 10 actviy 10 epart skp 10 Ihe Revien page
ifur Dyed Dvesel What You Will Nead
- Total Gallonage for al Fuei Types being reparted

Received Tax Not Paid Gals

®) Clear Diese!

+ Al data mecessary ta compiste Recaipt Sthecules (16,
CNG 2E) that Must D regoned
* All data necessary ta compiete Disbursement Schedules.
LNG (7A, 7D) tral must be regortec
Fropane « Oniy report the Schedules that are applicable 1o your
. retm
Other
% Summary of Created Schedules
Schedule Type Product Type Gross Gallons
Recemwed Tax Pad Gals (1B) Clear Diesed 61,000 Show Scnedule Deste

Back [ Roview | Save 4Ext

12



Once all applicable schedules are created and saved, click “Review” to check the return for accuracy.

Ohio Motor Fuel Tax - Transporter MF OBG Test Acct
@ seect Fiing Perics Account Number
Tios
Filing Period Ending 093012015
O Enver otoma + Wnen enerngcunency values, 0o not use decimas
T
@ reiewanaric - When eferng galon values, da ot use decimals, Use
St e Mot
Transporter
-+ Use th Creae Schedke buon o crecteth selcted
@ confrmatan Schedue Type.

= Use Ihe Back buttan 1 FBAurT 10 1he previous page.

Select Schedule T Select Product Ty
vpe vpe * Use the Review button to procead to the Review page
Total Gals Loaded in OH/Delivered Out-of-State (14A) () Gasaline Create Schedule s bution DOES NOT Suomit e return
. « Use the Save and Exil bullon f you wan 10 5ave the data
otal Gals Loaded Out.of-State/Delivered to OH (148) @ Clear Diesel entisreq, but 3re nat r2a0) 10 SO your FetLM.
® Total Gals Loaded /Delivered in OH (14C) Low-Sulfur Dyed Diesel * It there is no activiy 1o report. skip 1o the Review page.
High-Sulfur Dyed Diesel [ R i
« Total Gallonage for  Fuel Types being reparied
Kerasene
+ All data necessary to compéete Transporter Schedules.
ONG (14A_ 148, 14C) that must be repored.
~ Oniy report the Scheduies that are appikcable t your
LNG reluin
Propane
Cther
Summary of Created Schedules
Schedule Type Product Type Gross Gallons
Total Gals Loaded in OH/Deliversd Out.of: State (14A)  Clear Diesel 119,000 Snow Schedue

Total Gals Loaded Out-of-State/Delivered to OH (14B)

ar Diesel 32,000 Show Schedus

Diesel 158

Show Schedue

Total Gals Loaded /Delivered in OH (14C)

Back =1 Save & Exit

13



The system populates the return details by compiling the entered schedules
Click the product type link (in blue) to extend or collapse the details of that product type.

If you disagree with the summarized values, review and/or edit the schedule details by clicking the
“Back” button and making the appropriate corrections.

When you are satisifed that the summarized values are correct, select “File” to complete and submit the
return.

** Total received gallons must equal total exported gallons

Ohio.go

TATE OF OHIO

Ohio Motor Fuel Tax - Exporter MF OBG Test Acct

[ Jr— P

Tips
Filing Penod Ending 08302015 Original
@ eoter iniomation a J o + Use the Back butien o returh 1o he previcus page 1o
mave any neecen conectars
© Review andFile Schedule Summary + Usa the Fike butfon to submit your compiated retum
+ Use the Save and Exit buton to save your retum witncut
fling snd refum o 0BG
@ corrmaton - Clear Diesel
Line  Schedule Name Schedule Gallons.
Recerved Tax Paid Gals 18 61,000
Recerved Tax Not Paid Gal 2€
3. Total Received Gals 61,000
4 Exported Tax Paid Gals 7 66,500
Exported Tax NotPaid Gals 7D
6 Total Disbursed Gals 66,500
LNG
Total Product Received 1,019,558
Total Product Disbursed 161,500

Back Save & Ext

14



Once the screen below is displayed, your return has been filed. If you have any questions
regarding your return, please refer to the “Filing Confirmation” number when contacting the
Department.

If your return is filed timely there will be no balance due, you can click the “Exit” button. You will be
returned to the Home Page and your filing is complete through the OBG. Please submit your payment
through the Ohio Treasurer of State’s Office.

** |f the return is filed late, the system will calculate penalty. The amounts will be displayed and
included in the “Balance (Refund) Due”.

If you will be making your payment via ACH Debit using the OBG, you can enter the “Payment Amount”
(which is defaulted to the Balance Due) and click “Send to Checkout”.

The return can be printed by selecting “Print View”. The return will also be stored in the efiling History
and can be reviewed/printed at a later time.

**Instructions for making payments can be found in the Self Help eLibrary. The link below will lead you
to a list of videos for Ohio Motor Fuel taxes.

http://www.tax.ohio.gov/self help/excise.aspx

“ETATE OF OHIO :

Ohio Motor Fuel Tax - Exporter MF OBG Test Acct

@ seicer Fiing Perio @) Your retumn has been successfuly filed. Dato and Timo of Fikng 09(28/2015 02:30 P
Tips
This eanfirmation acknowledges that your Ohio Metor Fuel Expornter tax retum for the peried stated below has been fled with the Ohio Department of Taxation.
@ coer nformaton - Record your g confematon umier or your ecoets
Please refer to the Filing Confirmation Number listed below when contacting the Excise and Energy Tax Division. + Use the Sand to Checkau bulon 1o add your paymeni fo
@ RevewandFie he checkoutin OBG. You wil be redresisd ta e OBG
o page o compiste your payment
— Filing Confirmation 833111896588 * Use the EXt button 10 pay later. You will e reaineted 1o
@ confirmation the 0BG home page.
Azcount Number + You can print electronically ed refurms by selecting tne
Print View butlon or from eFiing History
Filing Period 090172015 - 091302015 Original
Penalty $0.00
Less Payment | Credils 5000
9 Total Balance Due
= 0.00
as of 091262015 -
Paymant Amount s Send to Checkaut Print View Exit

* I you pay later than today, the balance may change to include any applicable interest and panalties. ¢

Contact Us

15


http://www.tax.ohio.gov/self_help/excise.aspx

Instructions for File Upload

Enter your Account Number (8 digit Motor Fuel Tax Account Number) and Filing Period End Date. Next,
select the Type of Filing and the Method of Filing. Click “Next” to continue.

** File validation occurs nightly. The file(s) will be ready for the next step within 24 hours.
Ohio.go

WELCO!

STATE OF OHIO

Ohio Motor Fuel Tax - Motor Fuel Electronic Filing Acct

0 Select Filing Period * All fields are required "
ips

@ coer Information Account Number JOO0O0CK o T e
period ending can be made here prior to filing the
. Review and File Filing Period End Date 1031115 % mmidaryyyy

+ The Gancel button will return you to the previous
page and no data entered will be saved

Type of Filing ® Original
. Confirmation * Use the Next button fo proceed fo the next page.

- Amendes + nly select “Upload Files® Method of Filing if a file
Method of Filing ® Upload Files g:i::;ﬂegfgve?;::mﬁ ‘specs provided by the

Manual Form Entry
‘What You Will Need

- 8 digit account number_ (New account number

Cancel provided by Department of Taxafion)

+ End Date of the Filing Month

+ Total Galonage for all Fuel Types being Reported

+ Al data necessary to complete Receipt Schedules
(1, 2, 3, 4) that must be reported

+ Al data necessary to complete Disbursement
Schedules (5, 5AD, 6.7, 8, 10, 10B) that must be
reported.

- Al data necessary to complete Inventory
Schedules (15C) that must be reported.

+ Al data necessary to complete Transporter
Schedules (14A, 148, 14C) that must b reported

- Cnly report the Schedules that are applicable to
this retum

Contact Us

16



Enter your e-mail address, then click “Browse” to locate and select the file you want to upload for

validation

Ohio Motor Fuel Tax -

@ select Filing Period
@ Enter Information

@ Review andFie

@ confimation

Account Number

Filing Period Ending 10312015 Original
@ L C‘: @ °
Upload files An email is Go to Motor Check files. Review the Click File to
for validation sent when Fuel Incomplete for errors. Summary complete the
the validation Transactions process
process is to link to the
complete next step.
Email Address (required)
An email will be sent to this address when the file(s) have been processed for errors:
Example@testohio.com
Click Browse to search for the file(s). Maximum upload is 4 files with a maximum of 5,120 KB (5 MB) each
Browse
OHFD-0715 txt
File Name Size Action

No files uploaded

If you click "Cancel” or close the window before clicking "Send for Processing,” the uploaded files will not be saved.

Tips.

Motor Fuel Electronic

If you have more than one file, the files must be
uploaded all at the same time in the same
transaction. Additional files cannot be added ata
Iater time o date.

File validation occurs nightly. The filefs) will be:
ready for the next step within 24 hours.
Acceptable lectronic fiing methods are text
(ASCII) and XML

Oy text (ASCI) fles (*.txt) of compressed files
(*.2ip) format will be accepted for upload.

Each file uploaded cannot exceed 5,120 KB or 5
MBin size. Files larger than this must be spit into
two, or compressed to reduce file size.

Compressed files (* 2ip) may only contain a single
file type of efther * tct of * xmi_Compressing more
than one file In the same archive will cause file
validation to fail

Use the Cancel button to cancel the upload
transaction and retum to the Main Menu

Use the Send for Processing button to submit the
uploaded file(s) for validation.

Once the file has been selected, click “Send for Processing” this will start the process of validation.

Ohio Motor Fuel Tax -

@ select Filing Period
@ Enter Information
@ ReviewandFile

@ confimation

Account Number

Filing Period Ending ~ 09/30/2015

Original

Upload files An emailis
for validation sent when
the validation
process is
complete

Email Address (required)

& @

Go to Motor Check files
Fuel Incomplete for errors
Transactions
to link to the
next step

An email will be sent to this address when the file(s) have been processed for errors:

exmaple@taxohio.com

Click Browse to search for the file(s). Maximum upload is 4 files with 2 maximum of 5,120 KB (5 MB) each

Browse

File Name

OHFD-0715.txt

Cancel Send for Processing

Review the Glick File to
Summary complete the
process
Size Action
627 KB Delete

If you click "Cancel” or close the window before clicking "Send for Processing,” the uploaded files will not be saved.
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Tips

Motor Fuel Electronic Filing Acct

If you have more than one fils, the files must be
uploaded all at the same time in the same
transaction. Additional fles cannot be added at a
Iater time or date.

File validation occurs nightly. The file(s) will be
ready for the next step within 24 hours.

+ Acceptable electronic fiing methods are text

(ASGII) and XML

* Only text (ASCII) files (*.bxt) or compressed files

(* zip) format will be accepted for upload.

- Each file uploaded cannot exceed 5,120 KB or 5

MB in size. Files larger than this must be split into
wo, or compressed to reduce file size,

+ Compressed files (*.zip) may only contain a single

il type of either %t or *.xml. Compressing more
n ane file in the same archive will cause file

validation to fail

Use the Cancel button to cancel the upload

transaction and retun to the Main Menu

Use the Send for Processing button to submit the
uploaded file(s) for validation



After sending the file for processing, a message confirming the file upload will be displayed. Next, select
“Return to Main Menu”. You will receive an e-mail the following day indicating the upload has been

processed. Once you have received the email confirmation, you can log back into OBG and resume the

transaction.

Ohio Motor Fuel Tax -

@ select Fiing Period
@ Enter Information

@ ReviewandFile

@ confmation

Account Number

09/30/2015 Ori

Filing Period Ending

N & @

Upload files An email is Go to Motor Check files
for validation sent when Fuel Incomplete for errors
the validation Transactions.
process is to link to the
complete next step

@ File(s) successtully uploaded for validation.
The file(s) below were uploaded for validation on Friday, September 18, 2015 at 10:37 AM

File Name
OHFD-0715 txt

An email will be sent to this address when error validation is complete:

exmaple@taxohio.com

If the email address is incorrect, the Status column on Incomplete Transactions will update once the files have been processed

Q

Review the
Summary

Status

Waiting for Processing

Please check back the day after uploading to see whether the status has been updated to reflect processing

tum to Main Menu

Click File to
complete the
process.

Tips

Motor Fuel Electronic Filing Acct

+ If you made a mistake and need to add/delets o

edit files, start a new transaction and upload the
required flles again

- File validation occurs nightly The fle(s) will be:

feady for the next step within 24 hours

After the file has been uploaded, but prior to receiving the email confirmation of completion, the

transaction will show as “Processing” on the Incomplete Transactions page.

Ohio Motor Fuel Tax
@ File a New Return
&\‘ Amend a Return
$ Make a Payment

-
Wl Filing History

Incomplete Transactions

I you rent ure site before you filed your retur, your saved draft will be listed below.

Click Resume to finish i, and Delete if you don't want to keep it
The draft returns are ordered by the most recent at the top.

Account Type Period Ending

Created By

Created Time

Original 09/30/15

MotorFuell

09/18/15 10:34 AM

Processing

Showing 1 to 1 of 1 entries

18

Tips

+ Do not use the back bution in your browser to
vigate.
- Toflle anew return, make sure your account
+ An original return must be on file in order to fie an
t

+ Payments may be made with a checking or

+ View and print online fiiings through eFiling

+ Sessions have a time out limit of 20 minutes. If the

+ Find historical payments paid online through 0BG

+ For optimal browser compatibily, please see
“Help®

Motor Fuel Electronic Filing Acct

number and fiing period are available.
amended return.

savings account using ACH debit or through the.
Treasurer of State Using ACH credit

eFiling History
History.

Session Time Out

session time exceeds this lmit, you will need to log
back into OBG.

Payment History
by clicking on the Home link at the top of this page

Browser Compatibility




After the validations have been completed and you receive the email advising you that you may
continue the filing, you will login back into OBG and go back into“Ohio Taxation — Ohio Motor Fuel Tax”.
Now under the Incomplete Transactions, you will see the status of the uploaded file(s).

For errors and error correction on uploaded files, see page 34 for instructions.

For files with no errors, select the “Ready” status link.

Motor Fuel Electronic Filing Acct

Ohio Motor Fuel Tax -

E] File a New Return Incomplete Transactions Tips
If you left the site before you filed your return, your saved draft will be listed below. + Do not use the baek button in your browser to
Click Resume to finish i, and Delete if you don'twant to keep it navigate
The draft returns are ordered by the most recent at the top. > T P Do E e
» number and filing period are available.
& AmendaRewm od End ) o
Account Type Period Ending Created By Created Time + An original retum must be on il in order to fle an
amended return.
Original 08/31/15 MotorFuell 091815 10:51 AM Read Delete - Payments may be made with a checking or
savings account using ACH debit or through the.
$ Make a Payment. Original 09130/15 MotorFuel1 09/18/15 10:34 AM Delete ‘Treasurer of State using ACH credit.

eFiling History

Showing 1 to 2 of 2 entries = View and print online fiings through eFiling
History.

-~
Wl <Filing History Session Time Out
- Sessions have a time out imit of 20 minutes. If the
session time exceeds this limit, you will need to log
back into OBG
Payment History
= Find historical payments paid online through 0BG
by clicking on the Home ink at the top of this page.
Browser Compatibility

= For optimal browser compatibiiity, piease see
"Help".

Click the “Next button to continue.

Ohio Motor Fuel Tax -

Motor Fuel Electronic Filing Acct

0 Select Filing Period * All fields are required
Tips
@ Enerinformation Account Number + Corrections to the Account Number, Filing Period
or Filing Type may bs made on this page.
@ ReviewandFile Filing Period End Date mmiddiyyyy  Files will NOT be revalidated so please ensure that
any changes made on this page correctly match
Type of Filing % Original the information contained within the successiully
. Confirmation Amended validated, uploaded file(s).
Method of Filing © Upload Files

Manual Form Entry
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Click “Review” to check the return for accuracy.

Ohio Motor Fuel Tax - Motor Fuel Electronic Filing Acct

@ select Filing Period Account Number
Tips
o . Filing Peried Ending ~ 08/31/2015 Original
Enter Information + The retumn is not yet complete. The submit time is.
recorded on the filng date not the date the files
were uploaded for validation

+ If tnere is a mistake on the Account Number,

Filing Period or Filing Type, changes can be made
Confi it without having to upload new files. Click Back,
@ cormaten [‘ ° make the changes and then Review and File

+ Use the Back button to retum to the previous
page.

@ Reviewand File

Upload files An email is Go to Motor Check files Review the Click File to
for validation sentwhen Fuel Incomplete for errors Summary complete the + Use the Review button to proceed to the Schedule
the validation Transactions process Summary review page.
process is to link to the
complete next step

° The uploaded file(s) have no errors
The file(s) below were uploaded for validation on Friday, September 18, 2015 at 10:51 AM

File Name Status
OHFD-0715 (3).txt No Errors Found
An email was sent to this address for notification

example@taxohio.com

Next Steps:

1) Click the Review button to calculate the return
2) Click the File button to submit the retumn before the deadline to avoid any applicable penalty

Back Return to Main Menu

If you disagree with the summarized values, review and/or edit the schedule details by clicking the
“Back” button and making the appropriate corrections.

When you are satisifed that the summarized values are correct, select “File” to complete and submit the
return.

** Total received gallons must equal total exported gallons

Ohio Motor Fuel Tax - Exporter MF OBG Test Acct

@ select Fiing Period
Account Number Tis
i Filing Period Endins 01/31/2014 Original
. Enter Information 9 9 9 « Use the Back button to return to the previous
page to make any needed corrections.

9 Review and File » Use the File button to submit your completed

Schedule Summary retum.
) + Use the Save and Exit button to save your
. C""“’"“’“G’a' Clear Diesel return without filing and retur to OBG.
Line  Schedule Name Schedule Gallons
1 Received Tax Paid Gals 1B 35,000
2 Received Tax Not Paid Gals ~ 2E 0
3. Total Received Gals 35,000
4 Exported Tax Paid Gals 7A 35,000
5 Exported Tax Not Paid Gals 70 0
6. Total Disbursed Gals 35,000
Total Product Received 35,000
Total Product Disbursed 35,000

sk save st
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Once the screen below is displayed, your return has been filed. If you have any questions
regarding your return, please refer to the “Filing Confirmation” number when contacting the

Department.

If your return is filed timely there will be no balance due, you can click the “Exit” button. You will be
returned to the Home Page and your filing is complete through the OBG. Please submit your payment
through the Ohio Treasurer of State’s Office.

** |f the return is filed late, the system will calculate penalty. The amounts will be displayed and
included in the “Balance (Refund) Due”.

If you will be making your payment via ACH Debit using the OBG, you can enter the “Payment Amount”
(which is defaulted to the Balance Due) and click “Send to Checkout”.

The return can be printed by selecting “Print View”. The return will also be stored in the efiling History
and can be reviewed/printed at a later time.

**Instructions for making payments can be found in the Self Help eLibrary. The link below will lead you
to a list of videos for Ohio Motor Fuel taxes.

http://www.tax.ohio.gov/self help/excise.aspx
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http://www.tax.ohio.gov/self_help/excise.aspx

WELCO

STATE OF OHIO

Ohio Motor Fuel Tax - Exporter

@ seicctFing Perioa @ Your retum has been successfully filed. Dals and Tima of Fiing - 092872015 02:30 P

[ —

MF OBG Test Acct

Tips

This cenfirmation acknowledges that your Ohio Metor Fuel Exporter tax returm for the peried stated below has been filed with the Ohio Department of Taxation.

+ Record your fiing CoNfMaton NUTZEr 1or your reconds.

Please refer to the Filing Confirmation Number listed below when contacting the Excise and Energy Tax Division. + Use the Send to Checkout button to add your payment to

@ Review and Fie
o Filing Confirmation 833111896588
Confirmation

Azcount Number
Filing Period 09012015 - 091302015 Original
Penalty 50.00
Less Payment | Credits 5000
Total Balance Due
a5 ol 09126/2015 * Co
Payment Amount s Sand to Checkout

Print View

* if you pay later than today, the balance may change to include any applicable interest and penalties.

he checkout in OBG, You wl be redrecied to the OBG
home page to compiste your payment.

+ Use the Exit button 1o pay later. You will be redrecied io
the ©8G hoa page.

+ 0 £an BNt lectTonCaly Hed rEtums Dy seiestng e
PrintView bution or from eFiing Fstory

Exit

Errors on Upload Instructions

Click on the “Show Errors” link.
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Ohio Motor Fuel Tax -

E] File a New Return

If you left the site before you filed your return, your saved draft will be listed below.

Incomplete Transactions

Click Resume to finish i, and Delete if you don't want to keep it
The draft returns are ordered by the most recent at the top.

& AmendaReum
Account

Type

Period Ending

Created By

Created Time

Original

MotorFuelt

09/18/15 10:34 AM

Delete

s Make a Payment

Wl <Filing History

Showing 110 1 of 1 entries

Tips

- Do notuse the back button in your browser to
navigate.

+ To flle a new retur, make sure your account
number and filing period are avaiable.

+ An original return must be on file in order to fie an
amended return

- Payments may be made with a checking or
savings account using ACH debit or through the
Treasurer of State using ACH credit.

eFiling History
+ View and print online fiiings through eFiling
History.

Session Time Out

- Sessions have a time out limit of 20 minutes. If the
session time exceeds this Imit, you will need to log
back into 0BG
Payment History

+ Find historical payments paid online through 0BG
by clicking on the Home link at the top of this page-
Browser Compatibility

+ For optimal browser compatibilty, please see
"Help”.

Contact Us

Click the “Download Error File” button.

Review the error file and use the information to make corrections on your main upload file.

Ohio Motor Fuel Tax -

@ scicctFiing Period Account Number

Filing Period Ending ~ 09/30/2015

@ Enter information
@ ReviewandFile

@ confimation

Upload files
for validation

An email is
sent when
the validation
process is

complete

3 some errors were found.

Go to Motor
Fuel Incomplete
Transactions
to link to the

next step

'4

Correct the
errors

The file(s) below were uploaded for validation on Friday, September 18, 2015 at 10:37 AM

File Name

OHFD-0715 txt

An email was sent to this address for notification:

exmaple@taxohio.com

Next Steps:
1) Download any error files
2) Correct the errors

Status

Ermor

The files Download
have errors any error
files listed
below
Action

Download Error File

Upload the
files in a
new transaction

3) Start a new transaction using File a New Return to upload corrected files. If there were more than one files, files with no errors ¢an be reused but must be uploaded again

As this transaction cannot be completed, please delete it from Incomplete Transactions when it is no longer needed
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Tips

Motor Fuel Electronic Filing Acct

+ Status column will reflect the following status:
+ Emmors - No errors found andor Bad file
Errors indicates information is eitner
required and missing, formatted
incorrectly, or is not properiy substantiated
by the appropriate schedule.
- NoErrors found — The file was
suscessfully validated and s ready fo be to
be filed
Bad file - The file contents are eftner
corrupt or cannot be read (may be a
formatting related)
- Ifthe Download Error File button is present under
the Action column for a specific ile, click the
butten to access and download the error file

Error fles wil only report a maximum of 250
erfors. If your error report contains this amount, or
anumber close to this amount, please contact us

before uploading the corrected file S0 that we may
assist you with a successful fle validation



s . =~
File Edit Format View Help
2 387500 origin TCN Not Found,Invalid origin TcN P
2 387704 Invalid origin Tcn,origin TCN Not Found —
2 387381 origin TCN Not Found,Invalid origin TCN
2 387406 origin TCN Not Found,Invalid origin TcN
2z 387389 Invalid origin TcN,0rigin TCN Not Found
2 387399 Invalid origin TCN,origin TCN Not Found
2 387321 origin TCN Not Found,Invalid origin TcN
2z 387396 origin Tcn ot Found,Invalid origin TN =
2 387859 origin TCN Not Found,Invalid origin TCN
2 387309 origin TCN Not Found,Invalid origin TcN
2z 388073 Invalid origin TcN,origin TCN Not Found
2 387783 Invalid origin TeN,origin TCN Not Found
2 387414 or n TCN NoT Foun walid origin TcN
5 1146940 or n state is inval -
5 1144437 or n state is inva’
5 1143782 or n state is inva
5 1143354 or n state is inval
5 1146261 or n state is inva’
5 1145841 or n state is inva
5 1143598 or n state is inva’
5 1142827 or n state is inva
5 1143057 or n State is inva
5 1142487 or n state is inva’
5 1142622 or n state is inva
5 1141792 or n State is inva
5 1144121 or n state is inva’
5 1146293 or n state is inva
5 1143787 or n State is inva
5 1146438 or n state is inva’
5 1144885 or n state is inva
5 1143688 or n State is inva
5 1146760 or n state is inva’
5 1145125 or n state is inval
5 1142453 or n State is inva
5 1146455 or n state is inva’
5 1144435 or n state is inval
5 1141977 or n State is inva
5 1145092 or n state is inva’
5 1145317 or n state is inval
5 1144368 or n State is inva

Click “Return to Main Menu” to delete file and start a new upload process.

Next Steps:

1) Download any error files

2) Correct the errors

3) Start a new transaction using File a New Return to upload corrected files. Ifthere were more than one files, files with no errors can be reused but must be uploaded again.

As this transaction cannot be completed, please delete it from Incomplete Transactions when it is no longer needed

Retum to Main Menu

Click “Delete” to clear the uploaded file with errors.

Once the file is deleted, start a new return by uploading the corrected file and follow the process from
the beginning.

Ohie Motor Fuel Tax - Motor Fuel Electronic Filing Acct

i Tips.
E] File a New Return Incomplete Transactions
IF you left the site before you filed your return, your saved draft will be listed below. + Do nat use the back bution in your browser fo
Click Resume to finish it, and Delete if you don't want to keep it navigate.
The draft returns are ordered by the most recent at the top e A T o e ot T
> number and filing peried are available.
& Amend aRetum N ) oF
Account Type Period Ending Created By Created Time + An original return must be en e in order to fle an

amended retumn.

- Payments may be made with a checking or
savings account using ACH debit or through the
Treasurer of State using ACH credit

Original 09130115 MotorFuel1 09/18/15 10:34 AM

$ Make a Payment Showing 1101 of 1 entries
eFiling History
= View and print online filings through eFiling
History.

W eFiling History Session Time Out

+ Sessions have a time out imit of 20 minutes. If the
session fime exceeds this limit, you will need to log
back into 0BG
Payment History

+ Find nistorical payments paid onine thiough 0BG
by clicking on the Home link at the top of this page.
Browser Compatibility

- For optimal browser compatibilty, please see
"Help"
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Electronic Filing History
Your return filing history is retained on the OBG. From the Home page, Select “Ohio Taxation — Ohio
Motor Fuel Tax” from the “Start a Service or Transaction” zone.

WELCO

STATE OF OHIO

Home

Moter Fuel Electronic Filing Acct
Company ID : 4111
If you do not have access to a senvics o transactan, pleass see your company’s administrator(s) to request or verify your access.
Favorite Transactions
Go to Administration > My Information > Edit > User Preferences to establish or edit your list of favorite transactions.

Start a Service or Transaction

Select Service :|_Gelect Service-- =]

—Select Service—

Opportunities for Ohioans with Disabilities — BSVIBEP
Ohio Taxation — New Account Registration and Fuel Permit
Chio Taxation - Sales and Use Tax Created Date
There are no traj Ohio Taxation — Employer Withholding

Ohio Taxation — Commercial Activity Tax
[ PP Ohio Taxation — Wireless 911 Charges
There are no tra Ohio Taxation — Severance Tax
Ohio Taxation—Financial Institutions Tax
age.

Transactior|

Ohio Taxation — Petroleum Activity Tax
Ohio Taxation - Horse Racing Tax
Ohio Job & Family Services - UC Tax

| Taxation — Net Profit Tax
Municipal Taxation — Withholding Tax
Ohio Deferred Compensation
Ohio Dept. of Commerce - Unclaimed Funds
Equal Opportunity Division
InvestOhio
Ohio Development Services Agenc

To exit (logoff)

Ohio Taxation — International Fuel Tax Agreement

Ohio Taxation — Gross Casino Revenue Tax

Ohio Taxation - Kilowatt Hour Tax - Self-Assessing Purchaser
Ohio Taxation - Kilowatt Hour Tax

(Ohio Taxation — Natural Gas Distribution Tax

Ohio Taxation — Ohio Motor Fuel Tax

Next, click “Select” by the “Motor Fuel Tax-Exporter” option.

\fE OF OHIO

istration Logout

Home

Motor Fuel Electronic Filing Acct
Company ID - ==*1111
Ifyou 40 nothave scesss to = serviss or banssction, plesse ses your sampany's sdmintrsors) f request o verfy your scssss
Favorite Transactions
Go to > My Edit > User 1o establish or edit your list of favorite transactions.

Start a Service or Transaction
Select Service : [Ghio Taxation — Ohio Motor Fuel Tax

Ohio Taxation — Ohio Motor Fuel Tax

Ohio Motor Fuel Tax — Dealer
Ohio Motor Fuel Tax — Exporter

Ohio Motor Fuel Tax — Transporter

Ohio Motor Fuel Tax - Terminal Operator

Ohio Motor Fuel Tax Refund - Fuel sold out of Ohio or to US Gov.
Ohio Motor Fuel Tax Refund - Transit Buses

Ohio Motor Fuel Tax Refund - Industrial Purpose

Ohio Motor Fuel Tax Refund - Agricultural Purpose

Ohio Motor Fuel Tax Refund - School Districts

Ohio Motor Fuel Tax Refund - Casualty Loss

Ohio Motor Fuel Tax Refund - Retail Dealer Shrinkage Allowance
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Click on “eFiling History” on the left side of the page.

WELCO!

TATE OF OHIO

Ohio Motor Fuel Tax - Motor Fuel Electronic Filing Acct
i Tips
@ File 2 New Return Incomplete Transactions
If you left the site before you filed your retum, your saved draft will be listed below + Do not use the back button in your browser to
Click Resume to finish it, and Delete if you don'twant to keep it navigate.

The draft returns are ordered by the most recent at the top. * To file a new return, make sure your account

» number and filing period are available.
ﬁ\ Amend a Return No Incomplete Transactions 9P
+ An original return must be on file in order to file
an amended retum
« Payments may be made with a checking or
savings account using ACH debit or through the
S Make a Payment Treasurer of State using ACH credit

eFiling History

+ View and print online fiings through eFiling
Histol
Wl <Filing History Session Time Out
+ Sessions have a time out limit of 20 minufes. If
the session time exceeds this Imit, you will need
10log back into OBG.

Payment History

« Find historical payments paid oniine through OBG
by clicking on the Home link 2t the top of this:
page.
Browser Compatibility

« For optimal browser compatibility, please see
“Help'.

A list of the most recent 200 transactions will be available for review. Click on the “View” link to the
right to view more detail.

OBG eFiling History Page

Ohio Motor Fuel Tax - Exporter MF OBG Test Acct

eFiling History

Date Time Filed Account Type Filing Period Start Filing Period End Filing Conf #
091262015 03:55 PM Amended o, 091302015 633111892997
0912672015 02.30 PM Original 0900172015 091302015 633111896588
Showing 1102 of 2 entries revious | 1 R
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A new window will pop up with the return summary.

** Click the printer icon to print copy of return.

State of Ohio
Ohio Motor Fuel Tax - Exporter
Tax Return

Company Name: MF OBG Test Acct

Please print this page for vour records.

Account Number:

Date Filed: 09/28/2015

Filed By: obgtest22

Filing Confirmation: 833111896588

Filing Period- 09/01/2015 to 09/30/2015
Filing Type: Original

Less Payment/Credits: $0.00

Penalty: $0.00

Balance Due: $0.00

Reconciliation by Product Group

1) Gallons received for export, destination state tax
paid

2) Gallons received for export, destination state tax
not paid

3) Total gallons received by product group 958,558
4) Gallons exported, destination state tax paid 0 0

5) Gallons exported in bulk, destination state tax not
paid

6) Total gallons disbursed by product group 95,000

958,558

95.000

7) Total product received 1.019.558
8) Total product disbursed 161,500
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Electronic Payment History

To view the history of payments that have been submitted through the OBG, click the “History” link at
the top of the Home page.

Home History Administration Logout

Motor Fuel Electronic Filing Acct
Company ID 1

I#you 2o net

53 service ar transaction, please see your company's 8ministator(s) o request or veriy your access

Favorite Transactions |

Goto tion > My > Edit > User 10 establish or edit your list of favorite transactions.

Start a Service or Transaction |

Select Service ;| _Select Service-- =
Transaction Name ‘Created Date
‘There are no in progress.

Transactions Ready for Checkout (Ready to File and Pay)

There are no transactions ready for checkout. |

To exit (Iogoff) without submitting any transactions, click "Logout” at the top of the page.

This will display the payments made through the OBG. Click on “View Receipt” to see the confirmation
and receipt.

g STATE OF OHIO

Home History Administration Logout

History

Motor Fuel Electronic Filing Acct
Company ID : ***1111

You can search or fiter Ristory by specifying a service area, date range or confirmation number.

Service Area: Filing Date Range: 0BG Confirmation Number:

.
[Any =] | 17 ] |
Recent transactions may not be immediately available for viewing via History.

Payment Confi Filed
Ohio Motor Fuel Tax - Dealer Payment Only 1013412015 ACH Debit: $59.650.00 52644196 9/17/201512:06 PM | [ View Receipt
Ohio Motor Fuel Tax — Dealer Payment Only 1013112015 ACH Debit: $97,720.00 52644061 92015 815 AM | [ View Receipt
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You can obtain further details of the confirmation, by clicking “View.”

Transaction Confirmation and Receipt

Compzny Name  Motor Fuel Electronic Filing Acct
Company ID  #*##*1111

The following transactions will be sent to the respective agency that administers the service. Please nate the session confirmation number when calling the OBG Help Desk (866-644-6468).

et Instruction
nstructions may not be processed for raasons that includ insufficient funds and prohibited or blocked payments. You should raview your account statament to insure that funds have been transferred (settled). For ACH debit
payments, settiement is projected to be two business days after the date of this confi n (or the selected deferred payment if applicable). 1f the date falls on a weekend or holiday, settiement is prajected to be twa

( P
business days after the next business day. The actual settiamant date is dependent upan the processing timelines of the agency and thair bank

If multiple agencies are being paid, payment instructions will be processed separately so you will see multiple entries on your account statements.

Date/Time 9/17/2015 12:06 PM
Confirmation # 52644196
Receipt # 19305062
ACH Routing
ACH Account # FREERIEEREERG7H0
Transaction Defer Date | Payment Type [ Amount [ Fee |
Ohic Mator Fusl Tax - Dealer Fayment Only 10/31/2015 WA ‘ ACHDebit | $69,650.00 N-‘A‘ View

Home | [ Pant This Page
IF you need assistance with this page, please view our help.

The below screen is displayed.

Transaction Confirmation and Receipt

Company Name  Motor Fuel Electronic Filing Acct
SR Company 1D 111

Motor Fuel Dealer Tax Summary
Payment Instruction

Payment Confirmation

Account Number

Poymunt facelvt Session Confirmation ID : 52644196

Date Report Filed : 08/17/2015
Report Filed By : 0BG Manua
Filing Period : 10/31/2015
Account Type : Ohio Motor Fuel Tax - Dealer
Total Amount Due : $69,650.00
Prot_ | [_Done ] & SaweasPOF

assistance with th

Please contact the Excise and Energy Tax Division at (855) 466-3921 with any additional questions or
concerns.
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